WNLT version 2.3 19 April 2017

WNLT

Welsh Natural Language Toolkit

- L 9

Organisation Hypermedia Research Group, University of South Wales.

Project Team Daniel Cunliffe, Douglas Tudhope, Andreas Vlachidis, Daniel Williams

Funding Body | Welsh Government, under the Welsh-language Technology and Digital
Media Grant scheme.

This user guide provides background material and documentation for the Welsh Natural
Language Toolkit.

Version 2.3 of the toolkit provides functionality which allows the toolkit to be used outside
the GATE environment via a graphical user interface, command line interface or API. Version
2.3 of the toolkit also added support for Twitter.

This user guide will first discuss the CymrlE information extraction system and all of its
processing resources in the chapter 1. Chapter 2 outlines the steps on how to set up WNLT’s
CymrlE information extraction system in the GATE Developer (GUI) application. This user
guide will then describe how to use the WNLT’s graphical user interface (GUI), command
line interface (CLI) and application programming interface (API) in chapters 3, 4 and 5
respectively. Lastly, chapter 6 provides information about the added support for the CymrlE
information extraction system for Twitter.

The WNLT is distributed with the GNU Lesser General Public License version 3.

Manual | Description of changes

version

2.X Added documentation for WNLT’s GUI, CLI and API (chapters 3, 4 and 5). Add
documentation for TwitterCymrlE. Created Welsh version of this User guide

1.X Created documentation for WNLT’s CymrlE information extraction system and

added documentation for using the CymrlE information extraction system in
GATE Developer (chapters 1 and 2).

Authors | Daniel Williams and Andreas Vlachidis




WNLT version 2.3 19 April 2017

Table of Contents
R = 7= 1ol <=4 o 10 [ o SR 3
1.1 TOKENIZET e st 3
1.2, SENTENCE SPIEEN ceveiiiii i e e e e st e e e e e e s sennabreees 4
T T oY BN Y oY1 Tol o T - T4 =] U UUTRURP 5
1.4. Morphological Analyser (LEMMAtIZEr) ....ceccuvieeiieeeiie e 7
i T GV 1 o o | TP PP P PP UPPPRPPPPPPPIRt 8
2. Using the WNLT in GATE DeVveloper (GUI) ...ttt e 11
2.1. Loading WNLT iN GATE ...ttt ettt sttt s e saneene e 11
2.2. Loading the CymrlE system in GATE......ccoueeeiiiiiiiiciireeieee e eerirereee e e e eeseabrreereeeeessennns 12
2.3. Adding @ NewW Corpus in GATE .......ooiiiiiiiieeiiiiieeeeireeeessireeessaeeessssseeessssssaeessnssaeeesnnes 16
3. WNLT’s graphical user interface (GUI)........ueeeeeuiiee ettt e 20
0 R W T ot o ' =1 L Y U 20
3.2  IMIBNU ittt e e e e e 23
4, WNLT's command [in€ interface (CLI)...uueeiiiieiciiiieeeee ettt saarreee e e 24
S WINLT APLL ettt ettt e e s re e s n e e s s e e ne e saneeneesmneeneesaneens 25
5.1. Setting Up the WINLT APl .....ooiiieeie ettt ettt sttt st st sneesane e 25
5.2. Using the CyMIIEULIlItIES Class .......uueiieiieeecciiieeee e e ettt e e ctree e e e e e e e e araaneeee e 29
5.3, USING the CYMIIE ClaSS...ccceeiie ittt e e e e e et e e e e e e e e aaaaaeeeaaaeas 36
T Y o <] o @AYo o1 1 =TS 38
6.1. ANNOLAtioN SET TraNSTer ..c.uiiiiiee e 38
6.2. TextCat Language identification.......ccccccuueiiieciiieiccee e 40
6.3. EMOTICONS GAZETLEEY ccciiiiiieeeieee e 41
6.4, HAaShtag tOKENIZEN....ceeeiei e e e e e e e e s e rae e e e e e e e eeanes 42
6.5. TWEEE NOIMAlISEr e e 43
5.6, GATE DEVEIOPET ..uvtrveeiieeiieiicitiieetee e eeeeecertre et e e e e eesebbbereeeeeessesssbareeeseeesessssssraneeeeeessennnes 43
6.7, WINLT'S GUIL.cneriiiieeeee ettt st ne e 44
5.8 WINLT'S CLI..eeeeeeteeee ettt ettt ettt st sb e sttt e st e e bt e sab e e be e s b e e nbeesateenneeeaee 45
5.9, WINLT AP ...ttt ettt et e st be e et e e bt e sat e e beeeab e e bt e eabeenbeesaneenseeeane 46



WNLT version 2.3 19 April 2017

1. Background

The Welsh Natural Language Toolkit (WNLT) contains a set of four core Natural Language
Processing (NLP) processing resources that enable the development of generic
computational linguistic applications and contribute to the Welsh language technology
infrastructure a much needed open source NLP toolkit. The project builds on the General
Architecture for Text Engineering (GATE) by adapting and expanding existing processing

resources (plugins) to Welsh.
The Toolkit contains the following four processing resources:

e Tokenizer

e Sentence Splitter

e Part of Speech Tagger

e Morphological Analyser

The processing resources benefit from a combination of glossaries with algorithmic
arrangements that address specific linguistic behaviours of the Welsh language.

1.1. Tokenizer

The WNLT Tokenizer extends the default GATE Tokenizer and similarly splits the text into
very simple tokens such as numbers, symbols and words of different types. The Tokenizer
distinguishes words in uppercase, lowercase, and between types of symbols. The processing
resource uses a slightly modified version of the original GATE Tokenizer rules file and an
extended JAPE post-processing transducer adapting the generic output of the Tokenizer to
the requirements of the Welsh part-of-speech tagger.

1.1.1. Token Types
The WNLT Tokenizer delivers the same types of Tokens and Space Tokens with default
ANNIE Tokenizer as listed below:

e [Word] including the attribute 'orth' that takes the values; upperinitial, allCaps,
lowerCase, mixedCaps

¢ [Number] any combination of consecutive digits.

e [Symbol] any special character is a symbol

e [Space Token] white spaces which are divided into two types of SpaceToken - space
and control

1.1.2. Welsh Tokenizer Modifications

The Welsh Tokenizer uses a modified version of the GATE Tokenizer file
'AlternateTokeniser.rules' which originally splits hyphenated and apostrophised cases into
separate tokens. This behaviour is desirable due to the extensive and elaborate use of
hyphens and apostrophe in Welsh which differs significantly from English, for example use
of hyphens in adjectival compounds. A succeeding post-processing transducer joins under a
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single token several types of hyphenated and apostrophised constructs. The modified
version also merges punctuation and symbol under a single Token type named 'symbol'.

The modified post-processing transducer joins together in a single token the following
constructs:

e Hyphenated place names e.g. Llanarmon-yn-lal

e Compounds of the common prefix e.g. ad-dala, cyd-ddefnyddir, rhag-glorineiddia

e Separate constituents hyphenation for the cases d+d, d+dd, dd+d, dd+dd, ff+f, ng+g,
g+g, I+, ll+], t+h e.g. ladd-dy, cybydd-dod, cyd-dyfu, hwynt-hwy

e Apostrophe loss of vowel initialy e.g. 'Deryn

e Apostrophe loss of vowel medially eg. i'engoed

e Apostrophe loss of final consonant e.g. cry' for cryf hapusa' for hapusaf

e Apostrophe for common contractions, cases:i,m,n,r,w,ch,th

e Ordinals e.g. 1af, 2il, 3ydd, 4ydd

e Special cases of prepositions: Ar gyfer , Er mwyn , Yn erbyn, and Oddi followed by a
preposition

1.1.3. Init-time parameters
encoding -The character encoding to be used for reading the input

tokenizerRulesURL - The path to the Tokenizer rules files, the default file is located at
/resources/Tokeniser/WelshTokeniser.rule

transducerGrammarURL - The path to the post-processing transducer grammar, the default
JAPE file is located at /resources/Tokeniser/postprocess.jape

1.1.4. Run-time parameters
annotationSetName - The name for annotation set where the resulting Token annotations
will be created. It is optional, if left blank then the 'default' annotation set is assigned.

1.2. Sentence Splitter

The WNLT sentence splitter segments the text into sentences using the same set of JAPE
grammars used in ANNIE. Hence, it delivers annotations of type 'Sentence' and 'Split". It also
makes available an alternative ruleset (main-single-nl.jape), which considers newlines and
carriage returns differently. The alternative ruleset, similarly to ANNIE, should be used when
a new line on the page indicates a new sentence.

1.2.1. Sentence Splitter Modifications

The WNLT sentence splitter uses a list of abbreviations adapted to Welsh that help
distinguish sentence marking full stops from other kinds. The abbreviations list contains 330
entries of the following categories:

e Linguistic e.g. abs (absolute), cfst (synonym)


https://gate.ac.uk/sale/tao/splitch8.html#chap:jape
https://gate.ac.uk/sale/tao/splitch6.html

WNLT version 2.3 19 April 2017

e Narrative eg Brth (British) , e.e (for example)
e Science e.g. Seic (Psychology), Tiwt (Teutonic)
e Spatial e.g. Morg (Glamorgan)

e Temporal e.g. C.C (B.C), Mer (Wednesday)

1.2.2. Init-time parameters
encoding - The character encoding to be used for reading the input

gazetteerlListsURL - The path to the gazetteer list of abbreviations, the default list is located
at /resources/sentenceSplitter/gazetteer/lists.def

transducerURL - The path to transducer grammar, the default JAPE file is located at
/resources/sentenceSplitter/grammar/mainsingle-nl.jape

1.2.3. Run-time parameters
inputASName - The name of the annotation set used for input. It is optional, if left blank
then the 'default’ annotation set is assigned.

outputASName - The name of the output annotation set where the resulting Split and
Sentence annotations will be created. It is optional, if left blank then the 'default’
annotation set is assigned.

1.3. Part of Speech Tagger
The WNLT POS tagger is a modified version of the ANNIE's Hepple tagger. The tagger

produces a part-of-speech tag as an annotation on each word or symbol. The list of tags
used by the tagger is found below. The tagger uses a default lexicon which is based on the
Free (GPL) Dictionary Eurfa v3.0.

1.3.1. List of Tags

CC - coordinating conjunction: e.g. a, ac, fel, fod
CD - cardinal number

DT - determiner: e.g.y, yr, 'r

IN - preposition: e.g. am, ap, mewn

INT - interrogative: e.g. beth, ble, sut etc.

JJ - adjective

JIR - adjective comparative

JJS - adjective superlative

NN - noun singular or mass

NNS - noun plural

NNP - proper noun singular

NNPS - proper noun plural

NNM - noun masculine

NNF - noun feminine

PDT - pre-determiner: preceding an article or possessive pronoun; e.g. ambell, prif, rhai etc.
PP - pronoun

RP - particle, such as; gor, mi, na, nac, ni, ni's
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RB - adverb

UH - interjection, such as; eh, huh, nefi, sori etc

VB - verb, base form

VBD - verb past tens

VBDP - verb pluperfect

VBDI - verb imperfect

VBI - verb infinitive

VBF - verb future

PN - punctuation, such as"'[J(){} . —...-1.27“"""\\//

SC - special characters, all other cases such as £5%* etc.

1.3.2. Part of Speech Tagger Modifications

The WNLT POS tagger uses a lexicon of 168669 pairs of terms and tags originating from the
Eurfa dictionary. A mapping exercise has mapped the original Eurfa tags
(http://www.eurfa.org.uk/abbrevs.php) to ANNIE Hepple tagger like tags. Major

modifications applied on the original POSTagger and Lexicon classes for classifying Welsh
input. The classes were extended to recognise linguistic evidence that support word
classification of unknown words beyond the limits of the Eurfa dictionary.

1.3.3. Init-time parameters
encoding - The character encoding to be used for reading lexicons and rules

lexiconURL - The path to the lexicon of terms-tags pairs, the default lexicon is located at
/resources/postag/lexicon

rulesURL - The path to the ruleset file, the default ruleset file is located at
/resources/postag/ruleset

1.3.4. Run-time parameters
inputASName - The name of the annotation set used for input

outputASName -The name of the annotation set used for output. This is an optional
parameter. If user does not provide any value, new annotations are created under the
default annotation set.

baseTokenAnnotationType - The name of the annotation type that refers to Tokens in a
document (run-time, default = Token)

baseSentenceAnnotationType - The name of the annotation type that refers to Sentences in
a document (run-time, default = Sentence).

outputAnnotationType - POS tags are added as category features on the annotations of
type ‘outputAnnotationType’ (run-time, default = Token)
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posTagAllTokens - If set to false, only Tokens within each ‘baseSentenceAnnotationType’
will be POS tagged (run-time, default = true).

FailOnMissingInputAnnotations - if set to false, the PR will not fail with an
ExecutionException if no input Annotations are found and instead only log a single warning
message per session and a debug message per document that has no input annotations
(run-time, default = true).

1.4. Morphological Analyser (Lemmatizer)

The Morphological Analyser takes as input a tokenized GATE document. Considering one
token and its part of speech tag, one at a time, it identifies its lemma, mutation form and in
some cases an affix. These values are then added as features on the Token annotation. The
WNLT Morphological Analyser has significantly extended the original GATE Morphological
Analyser to address the linguistic behaviour of Welsh with regards to inflection and

mutation. The tool uses regular expression rules, a Lexicon of term-lemma pairs, a Gazetteer
and a post-processing JAPE transducer for validating mutation propositions. The tool allows
users to add new rules or modify the existing resources on their requirements.

1.4.1. Morphological Analyser Modifications

The rule file default.rul, which is available under the /resources/morph directory is modified
for the Welsh alphabet. The file contains regular expressions that address regular and
irregular forms of plural constructs. More information on how to write these rules can be
found in GATE user guide at
https://gate.ac.uk/sale/tao/splitch23.html#sec:parsers:morpher:rules

The tool uses a Lexicon of 168794 term lemma pairs for providing known lemmas, a post-
processing JAPE transducer for the identification of mutation forms focusing on contact
mutations of Soft, Nasal and Aspirate type. The lemmatization process is as follows:

1. Lexicon Lookup, if is a known word provide lemma from lexicon and exit, else if
unknown proceed to 2

2. Regular Expressions rules, resolve lemma using rules and in any case proceed to 3

3. Post-processing Transducer, identify cases of contact mutation based on contextual
evidence. Propose new lemmas based on the contextual evidence and hard-coded
Welsh language rules and proceed to 4

4. Check the validity of the proposed lemmas against a gazetteer of 168785 valid
Welsh lemmas and 5885 Welsh place names. If lemmas validate set the new lemma
and exit, else proceed to 5

5. Revert invalid lemma to original non-mutated lemma form.
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1.4.2. Init-time parameters

caseSensitive - By default, all tokens under consideration are converted into lowercase to
identify their lemma and affix. If the user selects ‘caseSensitive’ to be true, words are no
longer converted into lowercase

encoding - The character encoding to be used for reading lexicons and rules

gazetteerListsURL - The path to the gazetteer list of valid lemmas, the default list is located
at /resources/morph/gazetteer/lists.def

lexiconURL - The path to the lexicon of terms-lemma pairs, the default lexicon is located at
/resources/morph/lexicon

rulesFile - The path to the file containing the regular expression patterns, the default file is
located at /resources/morph/default.rul

transducerURL - The path to post-processing transducer grammar responsible for
identification and proposition of mutations, the default JAPE file is located at
/resources/morph/grammar/postprocess.jape

validationTransducerURL - The path to transducer grammar responsible for validating
proposed mutations against the gazetteer of valid lemmas, the default JAPE file is located at
/resources/morph/grammar/validation-main.jape

1.4.3. Run-time parameters
affixFeatureName - Name of the feature that should hold the affix value.

rootFeatureName - Name of the feature that should hold the root value.
annotationSetName - Name of the annotation set that contains Tokens.

considerPOSTag - Each rule in the rule file might have a separate tag, which specifies which
rule to consider with what part-of-speech tag. If this option is set to false, all rules are
considered and matched with all words.

failOnMissingInputAnnotations - If set to true (the default) the PR will terminate with an
Exception if none of the required input Annotations are found in a document. If set to false
the PR will not terminate and instead log a single warning message per session and a debug
message per document that has no input annotations.

1.5. CymrlE
CymrlE is an Information Extraction (Named Entity Recognition) system for Welsh. The name
CymrlE is a paraphrasis of GATE's Information Extraction system ANNIE (A Nearly-New

Information Extraction System). CymrlE adapts ANNIE to Welsh input using a modified

version of the NE Transducer of ANNIE targeted at the requirements of the Welsh language,
for example adjective — noun constructs. The system is using a wide range of Welsh
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gazetteer lists to support the task of Named Entity Recognition while it maintains some of
the original lists with a focus on person names and place names. CymrlE does not currently
include a co-reference resolution processing resource.

The default annotation types, features and possible values produced by CymrlE the same
used in ANNIE and are based on the original MUC entity types, and are as follows:

e Person
o gender: male, female
e Location
o locType: region, airport, city, country, county, province, other
e Organization
o orgType: company, department, government, newspaper, team, other

e Money
e Percent
e Date

o kind: date, time, dateTime
e Address

o kind: email, url, phone, postcode, complete, ip, other
e Identifier
e Unknown

1.5.1. CymrlIE Gazetteer lists

welsh_assembly_members, Major Type:person_full, Minor Type:government
welsh_charities, Major Type:organization, Minor Type:charity
welsh_coastal, Major Type:location, Minor Type:coastal

welsh_counties, Major Type:location, Minor Type:county

welsh_countries, Major Type:location, Minor Type:country
welsh_country_adj, Major Type:country_adj, Minor Type:COUNTRYAD)
welsh_country_denonyms, Major Type:country_adj, Minor Type:
welsh_currency_unit, Major Type:currency_unit, Minor Type:post_amount
welsh_date_key, Major Type:date_key, Minor Type:

welsh_date_unit, Major Type:date_unit, Minor Type:

welsh_days, Major Type:date, Minor Type:day

welsh_departments, Major Type:organization, Minor Type:government
welsh_facility, Major Type:facility, Minor Type:building

welsh_facility_key, Major Type:facility_key, Minor Type:
welsh_facility_key ext, Major Type:facility_key_ext, Minor Type:
welsh_festival, Major Type:date, Minor Type:festival

welsh_goverment, Major Type:organization, Minor Type:government
welsh_govern_key, Major Type:govern_key, Minor Type:

welsh_greeting, Major Type:greeting, Minor Type:

welsh_hour, Major Type:time, Minor Type:hour
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welsh_ident_prekey, Major Type:ident_key, Minor Type:pre
welsh_jobtitles_cap, Major Type:jobtitle, Minor Type:
welsh_jobtitles_lower, Major Type:jobtitle, Minor Type:
welsh_jobtitles_sen, Major Type:jobtitle, Minor Type:
welsh_lakes, Major Type:location, Minor Type:lake
welsh_loc_generalkey, Major Type:loc_general_key, Minor Type:
welsh_loc_key, Major Type:loc_key, Minor Type:post
welsh_loc_prekey, Major Type:loc_key, Minor Type:pre
welsh_ministry, Major Type:organization, Minor Type:government
welsh_months, Major Type:date, Minor Type:month
welsh_mountains, Major Type:location, Minor Type:mountain
welsh_number_fold, Major Type:number_fold, Minor Type:
welsh_numbers, Major Type:number, Minor Type:
welsh_ordinals, Major Type:date, Minor Type:ordinal
welsh_org_base, Major Type:org_base, Minor Type:
welsh_org_key, Major Type:org_key, Minor Type:
welsh_org_pre, Major Type:org_pre, Minor Type:
welsh_parishes, Major Type:location, Minor Type:parish

10
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2. Using the WNLT in GATE Developer (GUI)

This chapter will take you through the basic steps of loading the CymrlE system and
processing a small corpus of BBC Cymru Fyw news stories. The guide is split into three
sections. The first section is about loading WNLT in GATE using the CREOLE plugin manager,
the second section is about loading CymrlE and processing a corpus, and the third section is
about creating, populating and processing a new corpus in CymrlE pipeline.

2.1. Loading WNLT in GATE
Step 1: From the File menu in GATE open the CREOLE Plug-in Manager by choosing the
Manage CREOLE Plugins option.

File| Options Tools Help

?ﬁmew Application P
@ New Language Resource J ;
{%‘% Mew Processing Resource b
Datastores 9
'*: Ready Made Applications »

@ Restore Application from File...

% Reload Recent Application b

=

*.. Manage CREOLE Plugins...

\@J Exit GATE Alt-F4
[ B

Step 2: From the new window (CREOLE Plug-in Manager) click on the plus sign located at the
top-left corner of the window.

Step 3: A new dialog box appears, click on the Select a Directory button and select the
directory WNLT which is located in your local drive to the place where you have
downloaded and extracted the WNLT-CymrlIE.zip.

Step 4: Once you have selected WNLT from your drive click Open in the dialog box

Step 5: The path to WNLT should now appear in the white box of the dialog window, click
OK to close the window

11



WNLT version 2.3 19 April 2017

Mstalled Plugins r # Available Updates |/ ‘A\railable to Install |/ ./ configuration |

o= )= CREOLE Plugin Directories Filter:
T 0adl Load ] ‘| Resources in Plug
Now | Always Plugin Name /|| AlchemyAPI: Entit
AlchemyAPI ||| AlchemyAPI: Keyv
@ D D /home/andreas/Apps/Gate-8.0/plugins/ AlchemyAPI TE
@ O O Alignmant s .
‘ha Register a new CREOLE directory X
[ AN
D D fhol )
Type a URL Sele ctory
L= An
& & Ihol or Q
Co
@ = = Ihol
Co OK | | Cancel ‘
@ D D /hol
m m Crowd_Sourcing
/homef/andreas/Apps/Gate-8.0/plugins/Crowd_Sourcing
O O Developer_Tools
/home/andreas/Apps/Gate-8.0/plugins/Developer_Tools
DocumentNormalizer
@ D D Jthamalmndrasc! AnnceffRasta-8 NinloaincMamsmandlarmslizae

Step 6:The WNLT plugin should now appear in the list of plugins as seen below. Check the
Load Now checkbox, click on Apply All button and Close the CREOLE Plug-in Manager
window

TN TIRS] cATNUNE S RS ARl e ) PRILILJIN S VP B L AW VY RS s

WRHNLT
/homefandreas/workspace/WHLT

@@
=]
O

O O WordNet
/homefandreas/Apps/Gate-8.0/plugins/WordHNet
(oo ).
—

2.2. Loading the CymrlIE system in GATE
Step 1: From the File menu in GATE load CymrlE by choosing the Restore Application from

File option.

12



WNLT version 2.3 19 April 2017

Eile| Options Tools Help

?‘New Application 3 ;
@ New Language Resource ] E
ﬁ Mew Processing Resource bl
ﬁ Datastores J
a Ready Made Applications b

@ Restore Application from File...
ﬁ Reload Recent Application b

-E- Manage CREOLE Plugins...

L&J Exit GATE Alt-F4
| E|

Step 2: Select the file CYMRIE.gapp located in the WNLT folder and click Open

Select a file for this resource ®
Look In: |CIWNLT | ||| 53| || e8] e
1 bin dsrc
Jdoc J wnlt-datastore
] gazetteer ||j| CYMRIE.gapp
] grammar
] help
1 plugins
CJresources
File Name: |CYMRIE. gapp
Files of Type: |GATE Application files (.gapp, .xgapp) -
Open Cancel

Step3 : Inspect the loaded Processing Resources at the right hand side of GATE . You should
see list of processing resources like the one below. Also the corpus BBC Cymru Fyw is loaded
under the Language Resources and the wnlt-datastore is loaded under Datastores.

13
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(G GATE

T %‘Applicatiﬂns
% cYMRIE

e l@ Language Resources
@ BBC Cymru Fyw

T %‘E’ Processing Resources
%e CYMRIE NE
%, Flexible Gazetteer
€, CYMRIE Gazetter
ﬁ Morphological Analyser
ﬁ Part of Speech Tagger

ﬁ Sentence Splitter

ﬁTﬂkenizer
1

9 Document Reset

T ﬁ Datastores

l wnlt-dat...

Step 4: Double click on CymrlE application and the pipeline will appearing on screen as seen
below

Step 5: The BBC Cymru Fyw corpus should be already selected as the corpus for processing
as see below if not selected it from the dropdown box

Step 6: Click on Run this Application button

14
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GATE Developer 8.0 build 4325
File Qptions Tools Help

& ® BEx WS Y

G GATE : Messages a& CYMRIE ‘
? # Applications I Loaded Processing resources Selected Processing resources
gg;, CYMRIE — Name ) Type 1 < Name ! Type
3 .x‘ o || €& CYMRIE Gazetter ANNIE Gazetteer .:\ Document Reset .Do(umenl Reset PR
I : :‘ i:zlti'::nlrollct for :?ngmonc_lly run PR plpe‘llnts over corpora. .. Tokenizer ‘Welsh Tokeniser
I 2 i < L Sentence Splitter Welsh Sentence Splitter
? ﬁ' Processing Resources .- Part of Specch Tagger .Welsh POS Tagger
He CYMRIE NE @ 5§ Morphological Mafyser’Welsh Morphological Analyser
. Flexible Gazetteer .‘\. Floxible Gazetteer ‘Flexlbln Gazetteer
« CYMRIE Gazetter .." CYMRIE NE IANNIE NE Transducer

ﬁ Morphological Analyser
g Part of Speech Tagger
ﬁ Sentence Splitter

H Tokenizer

’ Document Reset

No processing resource selected...

Corpus: [& BBC Cymru Fyw

¢ ‘ Datastores No selected processing resource|
. wnit-dat... AP | AbAMA: Value
v
[ ”77777"*' [ — -
I ]
Resource Features | ‘VW“V"E this Application.|
2] o = [ »] | Serial Application Editor rfpjgla!!;g!on7@;{2@{3@;}7“

Step 7: Double click (or right click and open) on BBC Cymru Fyw corpus located in Language
Resources to view the list of documents contained in the corpus.

Step 8: Double click (or right click and open) on any of the documents in the corpus to open
it

File Options Tools Help
O & % %> 8 &2
G GATE q_j(l'b‘lessages ’/_%CYMRIE rﬁBBC Cymru Fyw

? ?‘Applications

o

% cYMRIE .
‘[open a document to load it from the datastore.
? @ Language Resources 2|(Iindex

9 BBC Cymru Fyw
e # Processing Resources

@ Cam-drin_plant.xml_00070

@ Criw'r_'Mimosa'.xml_00071

%E CYMRIE NE @ Cwestiynau_am_amserlen_Cyngor_Powys.xml_00072

A Flexible Gazetteer 47 Dathlu_2015_20mlynedd.xml_00073

& CYMRIE Gazetter @ Gwrthod_apel_yn_erbyn.xml_00074

ﬁ Morphological Analyser
ﬁ Part of Speech Tagger
ﬁ Sentence Splitter

ﬁTokenizer
o

0 Document Reset

? ﬁDatastores
' wnlt-dat...

@ Map_Llareggub.xml_00076

&7 patagonia_150.xml_00077

@ Siom_dros_ddosbarth.xml_00078

0
1
2
3
4
5@ Magu_neu_fygu.xml_ 00075
B
7
8
9

@ Toriadau'r_Trysorlys.xml_00079

10467 Tu_él_i'r_llenni.xml_0007A
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Step 9: Under the Language Resources double click (or right click and show) a document
from the list to view its contents

Step 10: Click on Annotation Sets to view the annotations produced by the pipeline.

GATE Developer 8.0 build 4525 T
Eile Qptions Jools Help
O @ 2EPF 8 Y
G GATE 24 Messages 3\7 CYMRIE ‘I BBC Cymru Fyw é " Cam-drin_plant..., 6 Criw'r_'Mimosa’... é Dathlu_201%5_20m...
? #Mw“mm’m TAnnotation Sets | notations List  Annotations Stack  Cowreference Editor  Text K‘ v
o o e =
R i o N TSTTRTETS ors garad s emeran y Wisds alY
¢ 038 Language Rosounoq oo oobrit y ot Ao | & Address
SRR o Mao digayddiadau yn cael eu cyninal ym MHStAGENE | nodi union ganaf a hanner ors it CYIEY cyntof ¥ Date
47 pathiu_2015_ 20miynedd.xmi | | 708 CE e syitiodau 0905 thwng CHINT a7 Anannm. = RERE
&7 Criw'r_Mimosa'.xml_00071 . — o
= B3 [Odydd Lun. bydd Artywydd yr Ananoin - CHSHRRFEIBNGEE de Kechnar - yn croesawu Prid Wainidog CYeifl Ll Lookup
& Cam-drin_plant.xml_00070 {Carwyn jones ¥ Person
& voc cymeu Fyw l9ydd y ddau yn mynd | wold cyfheyniad theatrig ym BABHE Madnn nos Lun, syn adeodd hanes yr yrmiudwyr | Sentence
cyntad, Ll SpaceToken
¢ ik Processing Resources "’m
JCORSONPIONA0! nou *Calon Aroesol’ yw teal y cynhyrchead, fydd yn cynnwys cerddonaeth a dawnsio acyny | | Sp
¥ee CYMRIE NE doyrnged | ysbeyd y CHIEY wnaeth 0508 gareiddiau tatath CHbRE, "l Token
i o | Unknown
. Flexible Gazetteer IF e laniodd tua 160 o GYIIY ar draath yn y Bae Newydd. PAYSGONIA o« 28 Gorfennal 1885, b oA0i000 askop
- riginal markups
& CYMRIE Gazetter Roadden ntw wedi tohio dros 7,000 o filtiroedd dros gyfnod o ddau fis ar fong fach y Mmosa
i 1 |
ﬁ Horphslogicat Analyser catio te oedd swyddogaeth y Mimosa. & chafodd ¢l haddatu ar frys | gario pobl gan wheud taah a fyddarn
ik n oh At
a Part of Speech Tagger anodd mewn amyichiadau da yn anoddach hth |
% Sentence Splitter Roedd nder o'r ymhudwyr yn 58 yn ystod y daith a bu farw pedwar o blant ar y mér.
s
p
53§ Tokenizer 2y farw pedwar arall ar 81 cyrraedd PORTR Madayn 3¢ roedd yr amgyichiadau 3 wynebars G yn anodd tu
< it - Bochest pren as y traeth a dffyg dvr yfed, » pheiter o 40 m: deithio ar draws tir ddfrwyth er
& vowment Reset i Hayn cyrraedd dyftoymifon Camwy a fyddain cynnig lloobiad ar gyt dhs cartrefs
s -""‘““""‘ < Heu greledigacth 0edd creu Gwiadla Gymeelg - thywle y byddal modd iddyn nbw fyw yn rhydd trwy ayfrwng y
‘ ~ 3 I 31 | HGymeaeg. gan arddel eu fiydd anglydifurficl a cynnal dwylliant Cymreig
T T tal HMaoT lath Gymraeg yn dal i'w chiywed mewn Uefydd fol y Gaiman a Trelew yn rwyrain Patagonia ac yn
MatchesAnnots | v (null-D} 1 fsauet s T'\':W")g'wﬁﬂdﬁ y Y y ¥ y ¥
MimeT toxtiplain 4
o idoid ,!f!‘f, o ,l' ",?d,'? wal Mae disgyblion yn drsgu’r tath mewn rhai ¢ ysgohon y dalath ac mae tua 50,000 o bobi Patagonia yn - -
docNewLineType v LF =H Chd > R New
« ] » || Document Editor  Initialisation Parameters | Relation Viewer

2.3. Adding a New Corpus in GATE
Step 1: From the File menu create a GATE Corpus by choosing New Language Resource >

GATE Corpus

Step 2: In the pop-up dialog box name the Corpus e.g. MyCorpus and click the OK button

Eile| Options Tools Help

y— New Application h_%

@ Mew Language Resource J '@"' Annotation Schema

ﬁ Mew Processing Resource J “ GATE Corpus -
]|

ﬁ Datastores L @ GATE Document L

w
7
o |
=4
=
iy
—
i
[}
=
v
]
i
O
[
(1]
=
w
=1
k]
=3
k]

i Ready Made Applications

ﬁ Restore Application from File... Mae digwyddiadau yn cael eu ¢
gyrraedd v Wiadfa ac i ddathlu

ﬁ Reload Recent Application »
Ddydd Llun, bydd Arlywyedd yr A

'ﬁ' Manage CREOLE Plugins... Canwyn Jones.

[g Exit GATE Alt-Fa  Byddy ddau yn mynd i weld oyt

murtaf.

Step 3: The new corpus should now appear on the left side panel under Language Resources
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Step 4: Save the corpus to the wnlt-datastore by right-clicking on the corpus icon and
selecting Save to Datastore

Step 5: From the pop-up dialog box select wnlt-datastore and click the OK button

(5 GATE : f Messages | i CYMI
9 #Applicatiﬂns Loaded Processing v
3 : Name
% CYMRIE Ml —=
: g CYMRIE Gazetter/A

T @ Language Resources

MyC -
€ MYCO e Ctrl-Fa
9 %&Pracesa show

-%E cymf Rename F2
Help

i Populate
ﬁ cyMH Populate from Single Concatenated File

% Save as XML...
Mor
- Save to Datastore...

E Part of Speech Tagger

e
GATE =
L Select the datastore
wnlt-datastore |v|
oK Cancel

Step 6: From the File menu create a GATE Document by choosing New Language Resource >
GATE Document

Step 7: In the new dialog box
a) Give a Name to the document, in this example 'Pryder am gynllun'
b) In the encoding field type utf-8

c) Select the document by typing a web address (URL) in this example
'http://www.bbc.co.uk/cymrufyw/35867934'

Alternative c) Instead of typing a web address you can Open a document from your local
drive by clicking the Folder button on the right hand side and selecting a local document of
your preference (list of supported document formats at
https://gate.ac.uk/sale/tao/splitch5.html#x8-940005.5)
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SENLENUE SpLLer VY EISTI DETLENce SpILLern

Parameters for the new GATE Document

Name: |Pryder am gynllun

Name Type |Required Value
(7} collectRepositioninginfo |Boolean|v” false |
(?) encoding String utf-8 [
(7} markupAware Boolean|+” true |
(?) mimeType String [
{7} preserveOriginalContent|Boolean|~” false /
(7} sourceUrl  [URL v http:/fwww.bbc. co.ukjcymrufyw/35867934 ( | ‘ @
{7} sourceUrlEndOffset Long
(7} sourceUr|StartOffset Long |

| oK || Cancel || Help |

Step 8: Double click on the Corpus (My Corpus) icon located under the Language Resources

to open the Corpus Editor

Step 9: Click on the Green Cross button (circled in red below) to open the Add document(s)

to this corpus dialog box

Step 10: Select the document (in this case Pryder am gynllun) and click the OK button

(G GATE

f Messages

% CYMRIE ﬁ MyCorpus

T %Applicatiﬂns

% CYMRIE

¢ @ Language Resources
@ Pryder am gynllun

&4

add or remove documents to this corpus

# use the toolbar buttons at the top ¢
# drag documents from the left resou
# right click on the corpus in the resol

ﬁ MyCorpus

T ﬁ Processing Resources
% CYMRIE NE
Q\-‘ Flexible Gazetteer
&, CYMRIE Gazetter

ﬁ Morphological Analyser

ﬁ Part of Speech Tagger
ﬁ Sentence Splitter

qrﬂkenizer
w

@ Document Reset

? ﬁ Datastores
' wnlt-dat...

ndex

Add document(s) to this corpus *

? @ Pryder am gynllun

OK

Cancel

Step 11: Double click on CYMRIE application (located in Applications) to view the pipeline as

seen below.

Step 12: Select MyCorpus from the Corpus drop-down box
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Step 13: Click the Run this Application button to execute the pipeline.

Eite Qptions Jools Help

GATE Developer 8.0 build 4825

& @ kWL

G cate

Applications

o omamE

anguage Kesources
& pryder am gynilun
‘7 MyCorpus

? #‘ Processing Resources
Fee CYMRIE NE
\ Flexible Gazetteer
dg CYMRIE Gazetter
ﬁ Morphological Analyser
g Part of Speech Tagger
ﬁ Sentence Splitter
H Tokenizer
O Dacument Reset

¢ [ vatastores
. wait-dat...

Tl
¥

[ Jl

luwm o ‘.uw.!

mtorpus saved |n 0.004 $e(onds

X Name
Document Reset

Type.

Document Reset PR

€ CYMRIE Gazetter ANNIE Gazetteer

Tokenizer Vielsh Tokeniser

Sentence spﬁluv Welsh Sentence Splitter

Pan nf Spo«h Tagger .Wclih POS l'aqqu
Movpholoqkal Alulysor Welsh Movphologlml Nu'ynt
. \ Flexible Gazetteer

Q!.. CYMRIENE

Flexible Gazetteer
ANNIE NE Transducer

~ No proces esour
QYes®s © No O Mvalue of feature © is |

f
I

No self<none>

Step 14: Double click the 'Pryder am gynllun' document icon from the Language Resources

to view the document

Step 15: Click on Annotation Sets button to reveal the produced annotations

Step 16: Toggle the Annotation Types ON and OFF from the left hand side panel by checking

- unchecking the relevant boxes.

f_lle gpﬂons Tools uelp

& @ N EN e

G GATE

9 #Appll:allons
e cymrie

) .& Language Resources
&7 Pryder am gynilun
ﬁ MyCorpus

9 -# Processing Resources
%e CYMRIE NE
%, Flexible Gazetteer
€ CYMRIE Gazetter

a Sentence Splitter

ﬁ Tokenizer

O Document Reset
? -Da(aslores

' wnit-dat...

ﬁ Morphological Analyser
a Part of Speech Tagger

3 [ & MyCorpus ) " @Av'rydorrnm gynll..:

Ambt_atlon's.a] Annotations List  Annotations Stack  Co-reference Editor :Q

0g-Ddwy
anolbarth
e-0rll selected
@D

Wales News

0CAB

rror/Gwall

ryder am gyn¥tun | achub swyddi dur Tata ym Mhort Talbot
1 Mawrth 2016

annu
image copyright Getty images
@ allai cwmni dur Tata drol cefn ar gynlluniau | achub y gwaith ym Mhort Talbot, yn &l undeb Community.

d aelodau'r bwrdd yn cwrdd yn [ndia ar ddydd Mawrth 29 Mawrth | drafod cynlluniau allal arwain at goll |«
1,000 o swyddi ar draws y DU gan gynnwys 750 ym Mhort Talbot .

nd bu aelodau undeb Community yn cwrdd & phrif weithredwr T8E8 yn Ewrop ddydd Uun wrth | bryderon
ynyddu y gallarr safle gau yn gyfan gwbl.

'm mis [enawr, dywedodd Tata bod yn rhaid ymateb | “amodau anodd iawn o fewn y farchnad®,

n 8l ysgrifennydd cyffredinel Community, m roeddy po-,nbllrwydd o golledion swyddi wedi bod
M *anodd i'w dderbyn” ond fod gweithwyr yn benderfy h unrhyw gynnig.

| o sicehau Ihwy
‘chwanegodd: “Mae adroddiadau sy'n awgrymu y gallal bwrdd Tata yn india withod y cynllun achub hwn yn
ryder | bawb a bydd Community yn gwneud popeth posib | sicchau fod y cwmni'n bwrw 'miaen 3 hyn.

Mae'r gweithwyr ym Mhort Talbot wed: cyflawni'c ¢yfan oedden nhw § fod | ac maen nhw'n haeddu

-~

efnogaeth Tata.”

1 al annu'r stori hon Yaglyn & rhannu
(Mlmel'ype w text/html bost 9
[gate.SourceURL |w http:iwww.bbd ™| |[facebook
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3. WNLT’s graphical user interface (GUI)

The WNLT’s graphical user interface (GUI) can be launched by double clicking the wnlt.jar
file in the root directory of WNLT’s folder. After the application is launched, the GATE API
and the CymrlE information extraction system will be initialised. The initialisation process

uses multiple threads and unavoidably utilises a lot of the CPU.

This application allows the user to use the CYRMIE information extraction system to

tokenize, lemmatize, find part of speech tags, get token types, get orthographies, get named

entities and get lookups performed by the CymrlE system.

|£ WHNLT GUI - CymrlE information extraction systemn

File
Corpus

FILE: C\Users\Daniel\Desktop\zTestData bd :
FILE: C:\WUsers\Daniel\Desktop\Corpus informatiomCar)
FILE: C:\Users\Daniel\Desktop\Corpus informationtCri
FILE: C:\Users\Daniel\Desktop\Corpus informationiCuye
FILE: C:\WUsers\Daniel\Deskiop\Corpus informationDat
FILE: C:\Users\Daniel\Desktop\Corpus information\Gwr
FILE: C:\Users\Daniel\Desktop\Corpus information\Mag
FILE: C:\Users\Daniel\DesktopiCorpus information\Map
FILE: C:\Users\Daniel\Desktop\Corpus information\Pat:
FILE: C:\WUsers\Daniel\Desktop\Corpus informatiomSio
FILE: C:\Users\Daniel\Desktop\Corpus information\Tori
TEXT: Mae'T pél-droediwr Ched Evans wedi gi ga...
URL: http:/fww.bbc.co.ukicymrufyw/37977039

S

Add documents
URL | http:#| Add

File(s) Add -

Copy & Pastetext | Add

CymriE Output

<2xml version="1.0" encoding="UTF-§'?>
<GateDocument version="3"
<l The documents features—=

L

=GateDocumentFeatures=
=Feature>
=hlame className="java lang String">gate Source URL=/Name=>
=Value className="java.lang. String™>http/fwww bbc_co ukicymrufyw/37977039=Nalue>
=IFeature=
<Feature=
=Name className="java.lang.String"=MimeType=/MName=
<Value classMame="java.lang.String"text/htmi=/Value=
=(Feature=
=IGateDocumentFeatures=
<l The document content area with serialized nodes —

=TextWithNodes=<Node id="0"/=Rheolau=Node id="7"f= <Node id="8"/=newydd=Node id="14"/= =Node id="15"=i=Node id="16"/> <

Node id="17"='gefnogi=Node id="25"="<Node id="26"= =Node id="27"=ysgolion=Node id="35"= =Node id="36"=gwledig=Node id

="43"/= =Mode id="44"/=-=Node id="45"= <Node id="46">BBC=Node id="49"/> <Node id="50"=Cymru=Node id="55"/> =Node id="5

6"/=Fyw=Node id="59"/=

=Mode id="60""=

=Mode id="61"=Linciau=Node id="68"/> =Node id="69"/=mynediad=MNode id="77"/=

=Mode id="78"=Neidio=MNode id="84"/> <Node id="85"=i=Node id="86"="r=Mode id="88"/= <Node id="89"/=cynnwys=Node id="96"/=
=Mode id="97"=Cymorh<Node id="104"> <Mode id="105"=Hygyrchedd<Node id="115"/~

<Mode id="116"/=BBC<Node id="119"= <Mode id="120"=iD<Mode id="122"/=

<Node id="123"/=Nofifications<Mode id="1367>

=Node id="137"/~Llywio=Node id="143"/= <Node id="144"/=drwy<Mode id="148">"r<Node id="150"= <Mode id="151">BBC<Node id
="1547=

=Node id="155"/=Newyddion=Node id="164"=

=Node id="165"/=Newyddion=Node id="174"/=

=Node id="175"/=Sport=Node id="180"/= -
=Node id="181"/=Tywydd=Node id="187"/= hd

{Tukens 1 Lemmas l Part Of Speech Tags l Token Types l Urlhugraphyl Sentences l Mamed Entities l Lookup l CymrlE

3.1. Functionality

The user can add URLs, Files and Welsh text to the application by using the ‘Add documents’

part of the application.

Add documents

URL  hitp:if

Add

File(s)

Add

Copy & Paste text Add

After documents (Files, URLs and/or Welsh text) are added, the user can select particular

documents to display more information, documents are selected from the ‘Corpus’ part of

the application.
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Corpus

FILE: Cillsers\Daniel\Desktop'zTestData b i
FILE: ClUsers\Daniel\Desktop\Corpus informationiCa

FILE: Cilsers\Daniel\Desktop\Corpus informationCri

FILE: Clsers\Daniel\Desktop\Caorpus information\Cw
FILE: Cilsers\Daniel\Desktop\Corpus information\Ci ath
FILE: Clsers\Daniel\Desktop\Caorpus information\Gwr
FILE: Cilsers\Daniel\Desktop\Corpus informationiag
FILE: CWlsers\Daniel\Desktop\Corpus information\Map
FILE: Cilsers\Daniel\Desktop\Corpus information\Pata
FILE: CWsers\Daniel\Desktop\Corpus information\Sion
FILE: Cillsers\Daniel\Desktop\Corpus informationyTari
URL: hitp2hwww. bbc.co.ukicymrufyw/37891120

TEXT: Mae' pél-droediwr Ched Evans wedi ei ga...

- vy L

The CymrlE information extraction system runs on the user selected document and the
system’s output is displayed in the ‘CymrlE Output’ part of the application.

CymrlE Output )
=?ml version="1.0" encoding="UTF-§"?= 4
=GateDocument version="3"= )
=l- The document's features—=
=GateDocumentFeatures=
=Feature=

=Mame classMame="java.lang.String"=gate SourceURL=/MName=

<\alue className="java.lang.String"=created from String=/alue=
=/Featura=
=/GateDocumentFeatures=
=l— The document content area with serialized nodes —=
=TextWithNodes==Node id="0"=Mae=Mode id="3"="r=Node id="5"'= =Mode id="6"=pél=Node id="9">-=Mode id="10""=droediwr=No
de id="18"= =MNode id="19"/=Ched=Node id="23"> =Node id="24"=Evans=Node id="29"> =MNode id="30"=wedi=MNode id="34""= <N
ode id="35"=ei=Node id="37"/= =Node id="38"=gael=Node id="42"/= =MNode id="43"=yn=Node id="45"= =Node id="46"/=ddieuog=N
ode id="53"'= =Node id="54"/=0=Node id="55"= =Node id="56"=dreisio=Node id="63"= <Node id="64"/=dynes=MNode id="69"= <No
de id="70"f=mewn=MNode id="74"= <Mode id="75"=gwesty=MNode id="81"= =MNode id="82"=yn=MNode id="84"/= <MNode id="85"=Sir=
Mode id="88"= =Node id="89"/=Ddinbych=MNode id="97"/= <Mode id="98"=yn=Node id="100"= =Node id="101"=2011=Mode id="105
"= =Node id="106"/=
=Mode id="107"=Dyma=Mode id="111"= =Mode id="112"=o0edd=Node id="116"= =Mode id="117"f=yr=Mode id="119"= <=MNode id="1
207=ail=Node id="123"= =Node id="124"=achos=Node id="129"/= =Node id="130"=ar=Node id="132"/= =Node id="133"=0l=Node
id="135""= =MNode id="136"=i=Node id="137"/= <Mode id="138"=Mr=Node id="140"> =Mode id="141"/=Evans=MNode id="146"> =MNo
de id="147"/= =Mode id="148"=27=Node id="150"= =MNode id="151"/= =Node id="152"=ennill=Mode id="158"= =Node id="1589"/=ap
El=Mode id="163"F= <Node id="164"=yn erbyn<MNode id="172"= =Node id="173"=y=Node id="174"= <MNode id="175"=dyfarniad=MNo
de id="184"= =Mode id="185"=gwreiddiol=Node id="195"==Node id="196""= "

P TP P PR I el O e WP [ U P P P TR W T o] SRS ) NPT [ O LT T o Tl O I P N PP PN P PRI Y il SRS N PP [ O T ' e U WP P T [ P R, 1 [ T SOt ' PP o P |

[Tokens l Lemmas l Part Of Speech Tags l Token Types 1 Drthographyl Sentences l Mamed Entities l Lookup l CymrlE

The ‘CymrlE Output’ part of the application shows the output of the CymrlE information
extraction system which is organised into different tabs. The ‘Tokens’ tab outputs each
token on a separate line.
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The ‘Lemmas’, ‘Part Of Speech’, ‘Token Types’ and ‘Orthography’ tabs output their results
corresponding to each token in the ‘Tokens’ tab.

The ‘Sentences’ tab outputs all of the sentences found by the CymrlE information extraction
system on each line. As each sentence can span multiple tokens and words the following
information is given in order:

e The start character offset in the URL, File or String for the sentence (inclusive)
e The end character offset in the URL, File or String for the sentence (exclusive)
e The corresponding start token (see Tokens tab) of the sentence (inclusive)

e The corresponding end token (see Tokens tab) of the sentence (inclusive)

e The sentence as a String

An example:

4166 4325 780 825 Pan o'n nhw'n danglo carot o flaen ein trwyn ni a cynnig ysgol £5m i ni, a oedd yn
deg i niidroi'r ysgol yna nawr, a'r plant yn diodde, falle, o achos hynny?

The ‘Named Entities’ tab outputs all of the named entities found by the CymrlE information
extraction system on each line. As each named entity can span multiple tokens and words
the following information is given in order:

e The start character offset in the URL, File or String for the named entity (inclusive)
e The end character offset in the URL, File or String for the named entity (exclusive)
e The corresponding start token (see Tokens tab) of the named entity (inclusive)

e The corresponding end token (see Tokens tab) of the named entity (inclusive)

e The type of named entity

e An array of features about the named entity

e The named entity as a String

An example:
662 678 100 102 Date {rule=DateName, ruleFinal=DateOnlyFinal, kind=date} 15 Tachwedd 2016

The ‘Lookup’ tab outputs the gazetteer lookups performed by the CymrlE information
extraction system. As each lookup can span multiple tokens and words the following
information is given in order:

e The start character offset in the URL, File or String for the lookup (inclusive)
e The end character offset in the URL, File or String for the lookup (exclusive)
e The corresponding start token (see Tokens tab) of the lookup (inclusive)

e The corresponding end token (see Tokens tab) of the lookup (inclusive)

e The lookup’s ‘majorType’ value

e The lookup’s ‘minorType’ value

e The lookup as a String
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An example:
407 410 66 66 organization company BBC
For more information on the ‘majorType’ and ‘minorType’ values see the section 1.5.1.

The ‘CymrlE’ tab shows the CymrlE information extraction system’s output in GATE’s xml
format. The output of this tab can be seen in the image above.

3.2. Menu
The File menu provides the user with additional functionality, as can be seen by the
following image.

Mew Crl+r
Save Ctrl+3
User Guide Ctrl+LJ
About Ctrl+H
Exit

The ‘New’ menu item removes all of the documents in the application. The ‘User Guide’
menu item shows this user guide. The ‘About’ menu item displays some information about
the WNLT project.

The ‘Save’ menu item opens a dialog which allows the user to choose what CymrlE output to
save and the directory to the save this information. This dialog saves the selected CymrlE
outputs of each URL, File and String of Welsh text in the corpus.

[ £ Save CymirlE cutput for each docurmnent in corpus >
(/] Tokens [+ Lemmas

(/] Part of Speech tags [/] Token Types

(/] Orthographies [/ sentences

[+/] Named Entities [+ Lookups

(V] GATE xmi

Save directory:

[ Check all J [ Uncheck all J [ Save J
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4. WNLT’s command line interface (CLI)

Users can use WNLT via the command line interface (CLI) by running the wnlt.jar file from a
command line interface. To display the help message of the WNLT CLI, use the following
command in the WNLT project’s root directory:

java -jar wnlit.jar help

This will output the following message:

Bl Command Prompt - m] X

d*, 'Input file or URL' and 'Output file' arguments which

s\Daniel\Des WHLTAWNLT s WWNLT-CYMRIE\WNLT >

The command line interface of the WNLT needs three arguments in order from the user:

1. Command —The data that the user wishes to save after the executing the CymrlE
information extraction system. The commands are listed in the image.
Input file — The input file or URL which contains Welsh text

3. Output file — The file to output the results of the CymrlE information extraction
system.

The user can use the CYRMIE information extraction system to tokenize, lemmatize, find
part of speech tags, get token types, get orthographies, get named entities and get lookups
performed by the CymrlE system.

As mentioned in the help message, to following arguments will tokenize the content of the
Cam-drin_plan.txt file and save the tokens to outputFile.txt

” u
o

java -jar wnlt.jar lemmatize “Cam-drin_plan.txt” “outputFile.txt”

The results in the output files are the same as described in chapter 2.
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5. WNLT API

The CymrlE information extraction system and all of its processing resources can be utilised
in Java code by using the WNLT API. The WNLT API also provides higher level functionality
such as tokenization and lemmatisation without using the GATE API directly, see 5.3. The
user can access the WNLT API using the classes located in the Java package wnlt.api

The following sections outline the setup process for including the WNLT API in an existing
Java project, how to use the WNLT API to create and reuse components of the CymrlE
information extraction system and how to use the Cymrl/E class which hides the GATE API
from the user.

Users who do not wish to use the GATE API or the data structures provided by the GATE API
should first follow the instructions outlined in section 5.1 then skip to section 5.3.

5.1. Setting up the WNLT API

WNLT has been developed using the framework provided by the GATE API (GATE
Embedded). In order to use the WNLT API, the GATE API also needs to be included in the
build path of the user’s Java project.

The following sections will outline the setup process using an Eclipse IDE. The quickest way
to setup a Java project for the WNLT APl is outlined in section 5.1.1. To setup your Java
project to use the latest or an existing version of GATE, refer to section 5.1.2.

5.1.1. Quick setup

Step 1: Include all of the necessary .jar files in your project’s build path. These are all the .jar
files located in the WNLT’s lib folder and the wnlt.jar file located in the root directory of the
WNLT folder.

It is recommended that the user creates a folder called lib in the root directory of the user’s
Java project then copy all of the .jar files into that folder.

Step 2: In Eclipse, click “Project” from the menu bar -> “Properties” -> “Java Build Path” ->
“Libraries”
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& Properties for MyProject

type filter text

Resource
Builders

Java Build Path
Java Code Style
Java Compiler
Java Editor
Javadoc Location

Java Build Path

(* Source [=* Projects B Libraries % Order and Export
JARs and class folders on the build path:

= JRE Systern Library [JavaSE-1.8]

Add External JARs...

a x
- v v
Add JARs...

Project References Add Variable...
Run/Debug Settings .
. Add Library...
Task Repository
Task Tags Add Class Folder...
Validation
WikiText Add External Class Folder...
Edit...
Remove
Migrate JAR File...
Apply
@
WL Cancel
H “" 7 H H H
Click “Add External JARs” then add all the .jar files in step 1.
& Properties for MyProject O X
| Java Build Path T
Resource o
Builders (™ Source L= Projects Ei Libraries ¥ Order and Export
Java Build Path JARs and class folders on the build path:
Java Code Style 8 ant-1.9.3,jar - CAUsers\Daniel\Desktop\WNLTUWNLT site\ WNLT-CYMRIE\MyProjectib ~ Add JARs..
Java Compiler o8 ant-launcher-1.9.3jar - C:A\Users\Danieh Desktop\WNLTWNLT site\WNLT- CYMRIE\MyProjectilib
Java Editor i3 aopalliance-1.0.jar - C:\Users\DanielDesktop\WNLT\WNLT site\WNLT-CYMRIE\MyProjectlib Add Btemal JARs...
Javadoc Location o4 apache-mimedj-core-0.7.2 jar - C:\Users\Daniel\Desktop\WNLTUWNLT site\WNLT-CYMRIE\MyProject lib :
Project References Add Variable...
- log apache-mimedj-dom-0.7.2.jar - C:\Users\Daniel\Desktop\WNLTVWNLT site\WNLT-CYMRIE\MyProject\lib
Run/Debug Settings o8 bemail-jdk5-1.45.jar - C:AUsers\Daniel Desktop\WNLTWWILT site\ WNLT-CYMRIE\MyProjectilib Add Library...
Task Repository a8 beprov-jdk15-1.45 jar - C:\Users\DanielDesktop\WNLT\WHNLT site\ WNLT-CYMRIEWMyProject\lib
Tesk Tags s commons-codec-1.9.jar - CA\Users\Daniel\Desktop\WNLTWWNLT site\WNLT-CYMRIE\MyProject\lib Add Class Folder..
Validation @8 commons-compress-1.8.1jar - C\Users\Daniel\ Desktop\ WNLTUWINLT site\ WNLT-CYMRIE\MyProject\lib
WikiText - X . ! Add External Class Folder...
g comrmons-io-24jar - ChUsers\Daniel\Desktop\WNLTAWHNLT site\WNLT-CYMRIE\MyProjectilib
e comrmons-lang-2.6.jar - Ch\Users\DanielDesktop\WNLTWWILT site\WNLT-CYMRIE\MyProject\lib .
e comrmens-logging-1.1.3 jar - CA\Users\Daniel\Desktop\WNLTWNLT site\WNLT-CYMRIE\MyProject\lib L
s flying-saucer-core-9.0.4jar - CA\Users\Daniel\Desktop\ WNLTYWHLT site\WNLT-CYMRIE\MyP roject\lib Remove
s fontbox-1.8.8 jar - C:\Users\Daniel\Desktop\WNLT\WNLT site\WNLT-CYMRIE\MyProjectilib
o8 gate-asm-5.0.3jar - C:\Users\Daniel\Desktop\WNLT\WNLT site\WHLT-CYMRIE\MyProjectilib el
(28 gate-compiler-jdt-4.3.2-P20140317-1600 jar - C:\Users\Daniel Desktop\WNLT\WNLT site\WNLT-CYMRIE\MyProject\lib sLiEie e
s gatejar - C:A\Users\Daniel\ Desktop\WNLTYWNLT site\WNLT-CYMRIE\MyProjectilib
(oo hamcrest-core-1.3.jar - C\Users\Daniel\Desktop\WNLTYWRNLT site\WNLT-CYMRIE\MyProject\lib v
Apply
® I

Click “Apply” then “OK”

Step 3: Copy the ‘plugins’
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5.1.2. Updating to the latest version of GATE
If the steps in section 5.1.1 have been followed then ignore the following steps as your
project is already setup.

Step 1: Download the latest version of GATE’s binary, source and documentation via
https://gate.ac.uk/download/

Detailed instructions

Release 8.2 (May 27th 2016)

Most users should download the installer package (~570MB):

» Generic installer for any platform - this is an executable JAR file that should run when
you double click it, if this fails run it from the command line using java -jar gate-
8.2-builds482-installer.jar

» Platform-specific installer for Windows

If the installer does not work for you, you can download one of the following packages
instead. See the user guide for installation instructions:

gate-8.2-build5482-BIN.zip is a binary-only package. [Around 550MB]
gate-8.2-build5482-SRC.z7ip is a source package. [Around 526MB]
ate-8.2-build5482-DOC.zip is a documentation-only package. [Around 31MB
. Inary + source + docs package.

The BIN, SRC and ALL packages all include the full set of GATE plugins and all the libraries
GATE requires to run, including sample trained models for the LingPipe and OpenNLP
plugins.

For version 8.2, we recommend Java 8 — the core and most plugins will work on Java 7,
but some plugins require 8. Mac users must install the full JDK, not just the JRE.

Step 2: Extract the contents of GATE’s zip folder

Step 3: Include all of the necessary .jar files in your project’s build path. These are all the .jar
files located in GATE’s lib folder and the gate.jar file located in GATE’s bin folder.

It is recommended that the user creates a folder called lib in the root directory of the user’s
Java project then copy all of the .jar files into that folder.

In Eclipse, click “Project” from the menu bar -> “Properties” -> “Java Build Path” ->
“Libraries”
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Click “Add External JARs” then add all the necessary .jar files in step 3.
& Properties for MyProject O X
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Java Build Path JARs and class folders on the build path:
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ant-launcher-1.8.3 jar - C:\Users\Daniel\Desktop\WHNLTYWHLT site\WHNLT-CYMRIE\MyProject\lib
acpalliance-1.0,jar - C\Users\DanielDesktop \WNLT\WNLT site\WRLT-CYMRIE\MyProject\lib
apache-mimedj-core-0.7.2 jar - C:\Users\Daniel\Desktop \WNLTYWHNLT site\WNLT-CYMRIE\MyProject\lib
apache-mimedj-dom-0.7.2 jar - C:\Users\Daniel\Desktop\WNLTVWNLT site\WMNLT-CYMRIE\MyProject\lib
bemail-jdk15-1.45 jar - C:\Users\Daniel\Desktop\ WNLTVWRNLT site\WNLT-CYMRIE\MyProjectilib
beprov-jdk15-1.45 jar - C:\Users\Daniel\Desktop\WNLTWWHNLT site\WNLT-CYMRIE\MyProjectlib
commons-codec-1.9,jar - ChUsers\Daniel\Desktop \WNLTYWHNLT site\WNLT-CYMRIE\MyProjectilib
commons-compress-1.8.1 jar - C\Users\Daniel Desktop  WNLTVWINLT site\ WNLT-CYMRIE\MyProject\lib
commons-io-2.4.jar - ChUsers\Daniel\Desktop\WNLTYWHNLT site\WNLT-CYMRIE\MyProject\lib
commons-lang-2.6,jar - C\Users\DanielDesktop\WNLTVWRNLT site\WNLT-CYMRIE\MyProject\lib
commons-logging-1.1.3 jar - Ch\Users\DaniehDesktop\WNLTVWILT site\WNLT-CYMRIE\MyProjectlib
flying-saucer-core-8.0.4,jar - C:\Users\Daniel\Desktop \WHLTYWHLT sitet WNLT-CYMRIE\MyP rojectilib
fontbox-1.8.8 jar - C:\Users\Daniel\Desktop\ WNLTVWHNLT site\ WNLT-CYMRIE\MyProjectilib
gate-asm-5.0.3 jar - C\Users\Daniel\Desktop\WNLTYWHNLT site\ WHLT-CYMRIE\MyProjectilib
gate-compiler-jdt-4.3.2-P20140317-1600.jar - C:\Users\Daniel\Desktop\WNLTVWINLT site\WNLT-CYMRIE\MyProject\lib
gate.jar - C\Users\Daniel\Desktop \WNLTWWHLT sitel WNLT-CYMRIE\MyProjectilib

hamerest-core-1.3.jar - C\Users\Daniel\Desktop \WHNLTAWHNLT site\WHNLT-CYMRIE\MyProjectlib

Add External JARs...
Add Variable...
Add Library...

Add Class Folder...

Add External Class Folder...

Edit...
Remove
Migrate JAR File...
v
Apply

Click “Apply” then “OK”

Step 4: Copy whnlt.jar located in the root directory of the WNLT folder into your Java

project’s lib folder and add it to the your project’s build path, instructions in previous setup.
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Step 5: Copy the ‘plugins’ and ‘resources’ folder into your Java project’s root directory.

5.2. Using the CymrlIEUtilities class

CymrlE is an information extraction (named entity recognition) system for the Welsh
language. The CymrlE information extraction system is accessible to Java developers from
the CymrlEUtilities class located in the Java package wnlt.api. The following sections will
outline key parts of the GATE APl and outline the CymriEUtilities class.

The WNLT has been developed using the framework provided by the GATE API. For this
reason, the CymrlEUtilities class produces the CymrlE information extraction system and all
of its processing resources as Java Objects from within the GATE framework. The
CymrlEUtilities class enables GATE Embedded developers to use, reuse and adapt the
components of the WNLT in new or existing GATE Embedded projects. Though the
functionality exposed by the CymriEUtilities class is targeted towards GATE Embedded
developers, non-GATE Embedded developers can use the CymrIEUtilities class with help
from the examples in the following sections.

The WNLT API also contains a CymrlE class which hides the GATE API code from the user.
Non-GATE Embedded developers may wish to use the CymrlE class which is outlined in this
chapter below in section 5.3.

5.2.1. Corpus (GATE API class)
The CymrlE information extraction system processes Corpus Objects located in the Java
package gate. The following code creates a Corpus with a Document.

try {
Gate.runInSandbox(true);

Gate.init(); // Initialise GATE
} catch (GateException e) {
e.printStackTrace();
}

Corpus corpus = Factory.newCorpus("StandAloneAnnie corpus");
Document doc = Factory.newDocument(new
URL("http://www.bbc.co.uk/cymrufyw/37655968"));

10. corpus.add(doc);

LooNOOTUVTEA,WNER

Line 2 tells GATE not to load any local configuration files when initialising.

Line 3 initialises GATE. This needs to be executed before functions are called by GATE’s
Factory class.

Line 8 creates a Corpus using GATE's Factory class. The GATE API requires GATE Objects to
be created using the Factory class.

Line 9 creates a Document using GATE’s Factory class.
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Line 10 adds the Document to the Corpus.

A Corpus Object holds a collection of Documents. More information can be obtained from
GATE Embedded’s user guide

5.2.2. CymrlEUtilities

The CymrlEUtilities class has a function called getCymrlE() that creates a new instance of
the CymrlE information extraction system in one line of code, see line 2 of code snippet
below. This CymrlE Object mimics the functionality seen in the CymrlE application in the
GATE Developer graphical user interface, see chapter 3.

1. try {

2. ConditionalSerialAnalyserController cymrie = CymrIEUtilities.getCymrIE();
3. Corpus corpus = getCorpus();
4, cymrie.setCorpus(corpus);

5. cymrie.execute();

6.

7. } catch (GateException e) {

8. e.printStackTrace();

9. } catch (IOException e) {

10. e.printStackTrace();

11. }

Line 4 sets a Corpus of documents to the CymrlE system then line 5 executes the CymrlE
system on those documents within the Corpus.

After the execute() function is run, the documents within the Corpus are annotated with
metadata by the CymrlE information extraction system. The user can extract information
from those annotations, such as tokens, lemmas, part of speech tags, token types,
orthographies, named entities and lookups performed by the CymrlEU system. More
information on how to extract this information from annotations can be found in section
5.2.3.

The CymrlEUtilities class also allows the user to get preconfigured processing resources
used in the CymrlE information extraction system. Each processing resource in the CymrlE
system can be obtained from the following functions in the CymrIEUtilities class,

e getAnnotationDelete()

e getWelshTokeniser()

e getWelshSentenceSplitter()
e getWelshPOSTagger()

e getWelshMorph()

e getFlexibleGazetteer()

e getANNIETransducer()
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The CymrlEUtilities class provides functions to get the default configurations of each
processing resource, for example, the getWelshTokeniserDefaultParameters() function
returns the default parameters used in the Welsh tokenizer processing resource of the
CymrlE information extraction system. The CymrlEUtilities class also provides functionality
that creates the processing resource given user specified parameters, for example
getWelshTokeniser(FeatureMap). The following snippet of code reuses the CymrlE system
and changes the ‘listsURL’ parameter of the DefaultGazetteer process resource.
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LCoOoNOATUVTE, WNER

26.

try {

ConditionalSerialAnalyserController cymrieController = new ConditionalSerialAnalyserController();
cymrieController.setName("Modified CymrIEUtilities");

// Replace the listsURL parameter's value using CymrIEUtilities's default parameters

FeatureMap defaultGazetteerParameters = CymrIEUtilities.getDefaultGazetteerDefaultParameters();
defaultGazetteerParameters.replace("listsURL", new File("gazetteer/lists.def").toURI().toURL());

DefaultGazetteer defaultGazetteer = (DefaultGazetteer) CymrIEUtilities.getDefaultGazetteer(defaultGazetteerParameters);

// Create flexible gazetteer using the new default gazetteer
FeatureMap flexibleGazetteerParameters = CymrIEUtilities.getFlexibleGazetteerDefaultParameters(defaultGazetteer);
ProcessingResource flexibleGazetteer = CymrIEUtilities.getFlexibleGazetteer(flexibleGazetteerParameters);

// Copied and modified from the getCymrIEUtilities() function
ArrayList<ProcessingResource> prsArrayList = new ArraylList<ProcessingResource>();
prsArrayList.add(CymrIEUtilities.getAnnotationDelete());
prsArraylList.add(CymrIEUtilities.getWelshTokeniser());
prsArraylList.add(CymrIEUtilities.getWelshSentenceSplitter());
prsArraylList.add(CymrIEUtilities.getWelshPOSTagger());
prsArraylList.add(CymrIEUtilities.getWelshMorph());
prsArrayList.add(flexibleGazetteer); // add modified ProcessingResource
prsArrayList.add(CymrIEUtilities.getANNIETransducer());

// Set Processing resources and initialise
cymrieController.setPRs(Collections.synchronizedList(prsArraylList));
cymrieController.init();

27.} catch (GateException e) {

28.

e.printStackTrace();

29. } catch (IOException e) {

30.
31.}

e.printStackTrace();
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5.2.3. AnnotationSet (GATE API class)
After the CymrlE information extraction system has been executed on a corpus, the

documents within the corpus are annotated with metadata by the CymrlE information

extraction system, such as tokens, lemmas, part of speech tags, token types, orthographies,

named entities and lookups performed by the CymrlE system. The following snippet of code

shows how the AnnotationSet (which contains many annotations) can be obtained.

LoOoNOTUVTE, WNBR

15

try {

ConditionalSerialAnalyserController cymrie = CymrIEUtilities.getCymrIE();
Corpus corpus = getTestCorpus();

cymrie.setCorpus(corpus);

cymrie.execute();

Iterator<Document> iterator = corpus.iterator();

while(iterator.hasNext()) {
Document document = iterator.next();
AnnotationSet annotationSet = document.getAnnotations();

}

. } catch (GateException e) {

e.printStackTrace();

. } catch (IOException e) {
16.
17.}

e.printStackTrace();

The following snippet of code shows how to retrieve all the lemmas of each token of a

Document.
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(o]

10.
11.

12.
13.
14.
15.

Document document = corpus.get(®); // first Document

AnnotationSet annotationSet = document.getAnnotations(); // get all annotations

Node node = annotationSet.firstNode(); // start from the beginning of the document
ArrayList<String> lemmas = new ArraylList<String>(); // create an ArraylList to store all lemmas

while(node != null) {
AnnotationSet orderedAnnotation = annotationSet.get(node.getOffset()); // get annotations given the current
position in the document

if(orderedAnnotation.getAllTypes().contains("Token")) { // if AnnotationSet contains a Token annotation then
Iterator<Annotation> annotationIter = orderedAnnotation.get("Token").iterator(); // get Token annotations
lemmas.add((String)annotationIter.next().getFeatures().get("lemma")); // There is only one annotation, get
the lemma value

}

node = annotationSet.nextNode(node); // move to next node (next position in the document)

The AnnotationSet and Annotation Objects are data structures generated by the GATE APl. Documentation for the AnnotationSet and

Annotation data structures can be found in GATE Embedded’s user guide.
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5.2.4. Known Issues

When creating a new corpus or document, developers must create these resources using
GATE’s Factory class. GATE creates references to those resources so to delete those
references (and free up memory for the Garbage collector), developers must use the
Factory class’s deleteResource() function and must not have any references to the corpus or
document within their own code.

Some processing resources such as CymrlEUtilitie’s ConditionalSerialAnalyserController
cannot be completely dereferenced using the Factory class’s deleteResource() function. For
this reason, the developer should limit the number of created instances. For most developer
use cases, only one instance of CymrlEUtilitie’s ConditionalSerialAnalyserController is
needed.
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5.3. Using the CymrlIE class

The CymrlE class is located in the Java package wnlt.api. This class provides functionality for
typical use cases of the CymrlE information extraction system. This class is targeted towards
non-GATE Embedded developers and hides all GATE API code from the user.

This class contains self-explanatory functions that accept File(s), URL(s) or String(s) (String(s)
of Welsh text) and functions that return the CymrlE information extraction system’s
tokenization, lemmatization, part of speech tags, token types, orthographies, sentences,
named entities and lookups performed by the CymrlE system. The functions are outlined in
the following image.

© CymrlE
of CymrlE()
@ getTokens() : String[][] ,
@ getlemmas() : String[][] ©" IESystem
@ getPartOfSpeechTags() : String[][] @ setURL(URL) : void
@ getTokenTypes() : String[][] @ setFile(File) : void
@ getOrthographies() : String[]] @ setString(String) : void
@ getSentenceSplits() : Sentencesplit[][] @ setURLs(URL[T] : void
@ getMamedEntities() : MamedEntity[][] @ setFiles(File(]] : void
@ getlookups(}: Lookup(][] @ setStrings(String(]) : void

CymrlE inherits from IESystem.

The following code finds the tokens and named entities in the content of two Files. The
returned result is a two dimensional array where the first index indexes the File (or URL or
String) and the second index indexes the result for that File. In the example below, the
second index indexes the token (Line 8) and the named entity (Line 9).

1. try {

2 CymrIE cymrie = new CymrIE();

3 cymrie.setFiles(new File[] {

4, new File("TestDatal.txt"),

5. new File("TestData2.txt")

6 })s

7

8 String[][] tokens = cymrie.getTokens();
9. NamedEntity[][] namedEntities = cymrie.getNamedEntities();
10. } catch (GateException | IOException e) {

11. e.printStackTrace();

12.}

Named entities, lookups and sentences are returned as Objects which encapsulate all the
information about the named entity, lookup and sentence. See following image for the
information that can be obtained from these Objects.

36



WNLT version 2.3 19 April 2017

G* MamedEntity
@ getType() : String
@ getMamedEntity() : String
@ getFeatureMap() : FeatureMap
@ . toString() : String
@ . compareTo(NamedEntity] : int
©° Lockup
@ getlookup() : String
@ getMajorType() : String
@ getMinorType() : String
@ o toString() : String
@ - compareTollookup) @ int
G* SentenceSplit
@ getSentence() : String
@ o toString() : String
@ - compareTo(Sentencesplit) @ int

The NamedEntity, Lookup and SentenceSplit Objects inherit from the AnnotationResult class
which encapsulates information about the character offsets and token indexes of the
NamedEntity, Lookup or SentenceSplit.

5" AnnotationResult
e° AnnotationResult{long, long, int, int)
of getStartOffset() : long
of getEndOffset() : long
@ F getTokenIndexFrom() : int
@ © getTokenlndexTo() : int
@ o toString() : String
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6. TwitterCymrlIE

Twitter is a social media platform where users can share content such as tweets. A tweet a
short message that is no longer than 140 characters. As tweets cannot be longer than 140
characters in length, users tend to shorten words, use slang, acronyms and abbreviations to
fit their message into a tweet. Tweets are user generated making tweets prone to spelling
errors.

TwitterCymrlE is an information extraction system for Welsh tweets. TwitterCymrlE reuses
the processing resources found in CymrlE and adapts the processing resources found in the
TwitlE information extraction system that is available in GATE Developer. The Tweet
Normaliser processing resource in TwitlE is of particular interest as it attempts to correct
spelling mistakes, shorten words, slang etc.

In addition to the processing resources outlined in chapter 1 for the CymrlE information
extraction system, TwitterCymrlE has adapted the following five processing resources from
TwitlE:

e Annotation set transfer
e Language identification
e Emoticons Gazetteer

e Hashtag Gazetteer

e Tweet Normaliser

Each processing resource will be discussed in more detail in subsequent sections.

6.1. Annotation set transfer

The annotation set transfer processing resource identifies the tweet and the metadata
associated with the tweet. If the supplied document is a JSON file obtained by using the
Twitter APl then the tweet and metadata is extracted from the JSON file. If the file is not a
JSON file the whole text is treated as a tweet. More information on what metadata is
available from Twitter JSON files can be found at
https://dev.twitter.com/overview/api/tweets

A ‘user mention’ is a word or phrase with no spaces starting with the @ symbol. A ‘user
mention’ is a particular user on Twitter. A hashtag is a word or phrase with no spaces
starting with the # symbol. A hashtag is a form of metadata that allows users to categorise
their tweet. Examples of user mentions and hashtags are shown in the following figure.
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| Photojournalism USW

2 Follow

Talk by @alamy @UniSouthWales today 2pm
cb205 cinema. Learn how to make £ from your

#photography. All welcome! #photojstudent §8J
2 3 100®

This processing resource enables TwitterCymrlE to execute subsequent processing
resources only on the tweet and not the whole Twitter JSON file. This processing resource
generates the Tweet, Hashtag, UserID and URL annotations.

6.1.1. Run-time parameters

annotationTypes — if annotation type names are specified for this list, only candidate
annotations of those types will be transferred or copied. If an entry in this list is specified in
the formOldTypeName=NewTypeName, then annotations of type OldTypeName will be
selected for copying or transfer and renamed to NewTypeName in the output annotation
set.

copyAnnotations — this specifies whether the annotations should be moved or copied. The
default value false will move annotations, removing them from
the inputASName annotation set. If set to true the annotations will be copied.

inputASName — this defines the annotation set from which annotations will be transferred
(copied or moved). If nothing is specified, the Default annotation set will be used.

outputASName — this defines the annotation set to which the annotations will be
transferred. This default value for this parameter is ‘Filtered’. If it is left blank the Default
annotation set will be used.

tagASName — this defines the annotation set which contains the annotation covering the
relevant part of the document to be transferred. This default value for this parameter is
‘Original markups’. If it is left blank the Default annotation set will be used.

textTagName — this defines the type of the annotation covering the annotations to be
transferred. The default value for this parameter is ‘BODY’. If this is left blank, then all
annotations from the inputASName annotation set will be transferred. If more than one
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covering annotation is found, the annotation covered by each of them will be transferred. If
no covering annotation is found, the processing depends on
the copyAllUnlessFound parameter.

transferAllUnlessFound — this specifies what should happen if no covering annotation is
found. The default value is true. In this case, all annotations will be copied or moved
(depending on the setting of parameter copyAnnotations) if no covering annotation is
found. If set to false, no annotation will be copied or moved.

6.2. TextCat Language identification

The TextCat language identification processing resource attempts to identify the language of
the tweet. The TextCat processing resource is available in GATE Developer. The creators of
TwitlE generated their own language models to identify whether a tweet is English, Spanish,
German, Dutch or French. This processing resource is intended to choose what processing
resources to execute next depending on the language of the tweet. TwitterCymrlE and
TwitlE assume the language (Welsh and English respectively) and do not make use of this
functionality but others are welcome to make use of this functionality.

TwitlE’s language identification processing resource results were replicated using the same
tweets that were used in the training and out of sample datasets (though some tweets were
deleted so they were excluded from the dataset). The training datasets for each language
model contained between 300-400 tweets and the out of sample datasets for each language
model contained between 400-500 tweets. Using the same out of sample dataset, TextCat’s
default language models were tested. For both language identification systems, a Welsh
language model created from 400 welsh tweets was included and tested. The average
performance can be seen from the following table.

No Welsh language model | With Welsh language model

TextCat TwitlE TextCat TwitlE
Accuracy 95.48% 95.55% 96.78% 96.51%
Precision 89.02% 90.26% 90.09% 90.45%
Recall 88.57% 88.88% 89.78% 89.00%
NPV 97.11% 97.19% 98.03% 97.89%
Specificity 97.26% 97.30% 98.15% 97.95%
F-Score 88.65% 89.02% 89.80% 89.34%

Without the Welsh language models, TwitlE’s adapted language models derived from real
tweets slightly outperformed the default language models supplied by TextCat. The
performance differences between the TextCat and TwitlE language identification systems
can be seen in the table below. The difference in performance is very small but there is a
1.25% increase in average precision in the TwitlE model.
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No Welsh language model | With Welsh language model
Accuracy -0.07% 0.27%
Precision -1.25% -0.37%
Recall -0.31% 0.78%
NPV -0.08% 0.14%
Specificity -0.04% 0.20%
F-Score -0.37% 0.46%

The result is different when including the default Welsh language model in TextCat and the
Welsh language model created from Welsh tweets in TwitlE. The average precision of TwitlE
is only 0.37% better than TextCat and the other performance metrics show TextCat
outperforming TwitlE.

TwitterCymrlE uses the default language models (Welsh, English, Spanish, German, Dutch
and French) distributed with TextCat to classify the language of the tweet. The TextCat
processing resource adds a “lang” feature to the “Tweet” annotation generated by the
Annotation set transfer processing resource.

6.2.1. Init-time parameters
configURL — The list of TextCat language models used to determine the language of the
tweet.

6.2.2. Run-time parameters
annotationSetName — The annotation set used for input and output; ignored
if annotationType is blank.

annotationType — If this is supplied, the PR classifies the text underlying each annotation of
the specified type and stores the result as a feature on that annotation. If this is left blank
(null or empty), the PR classifies the text of each document and stores the result as a
document feature.

languageFeatureName — The name of the document or annotation feature used to store
the results.

6.3. Emoticons Gazetteer
The emoticons gazetteer processing resource uses a gazetteer to normalise emoticons such
as :-) and :} to the emoticon :). This processing resource generates the Emoticon annotation.

6.3.1. Init-time parameters
caseSensitive — By default the gazetteer looks for matches irrespective of capital letters. If
the user selects ‘caseSensitive’ to be true, words are no longer converted into lowercase.

encoding — The character encoding to be used for reading the input.
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gazetteerFeatureSeparator — The unique sequence of characters that separates the key and
value in the listsURL file.

listsURL — The path to the gazetteer for normalizing emoticons.

6.3.2. Run-time parameters
annotationSetName — By default, left blank. The annotation set used for input and output;
ignored if annotationType is blank.

longestMatchOnly — If true then the longest match in the gazetteer is used.
wholeWordsOnly — If true then only match whole words.

6.4. Hashtag tokenizer

A hashtag is a word or phrase that is used as a form of metadata to help categorise the
tweet, see image below. The only constraints for hashtags are that they must only be
alphanumeric characters with no spaces. Users can use hashtags to indicate the event or
theme of the tweet or help others find their tweet by searching for the hashtag.

n AnalyticsTrader
I

Hello Twitter! #myfirstTweet

This processing resource attempts to split the hashtag into multiple words, to do this the
hashtag tokenizer does two things:

e Uses JAPE rules to identify camel casing (there is no constraint that the user must
use camel casing in their tweets).

e Uses the Eurfa dictionary and named entities used in the CymrlE information
extraction system to break up the hashtag into words.

6.4.1. Init-time parameters
gazetteerURL — The path to the gazetteer for Welsh words.

6.4.2. Run-time parameters
inputASName — The name of the annotation set used for input. It is optional, if left blank
then the 'default’' annotation set is assigned.
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outputASName — The name of the annotation set used for output. This is an optional
parameter. If user does not provide any value, new annotations are created under the
default annotation set.

6.5. Tweet Normaliser
This processing resource attempts to correct spelling mistakes as well as normalising slang
and shortened words.

Spelling mistakes are corrected by using the Eurfa dictionary and other gazetteers using in
the CymrlE information extraction system. Spelling mistakes are corrected by comparing the
Levenshtein distance between each word, if a word is found in the gazetteers with a
Levenshtein distance of 2 or less then it is corrected to that word.

To normalise slang a specialised gazetteer is used that contains Welsh slang and English
slang normalizations. This gazetteer takes words such as ‘I8 and normalises it to ‘later’.
After this processing resource is executed, it replaces the feature ‘string’ of the ‘Token’
annotation with the normalised word and moves the original word to a new feature called
“origString” within the “Token” annotation.

6.5.1. Init-time parameters
dictURL — Path to dictonary of words for correcting words with some Levenshtein distance.

orthURL — Path to common normalisation terms. For example, ‘b4’ -> ‘berfore’.

6.5.2. Run-time parameters
initialTextFeature — Feature on Token annotations in the input AS that contains the token
string.

inputASName — The name of the annotation set used for input. It is optional, if left blank
then the 'default’' annotation set is assigned.

maxDistance — Maximum Levenshtein distance to correct words.
normTextFeature — Feature to which the normalized text should be saved.
origTextFeature — Feature to which the original text should be saved.

outputASName — The name of the annotation set used for output. This is an optional
parameter. If user does not provide any value, new annotations are created under the
default annotation set.

6.6. GATE Developer
TwtterCymrlE can be used within the GATE Developer graphical user interface by following
these instructions.

Step 1: From the File menu in GATE choose the Restore Application from File option.
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Step 2: Select the file TwitterCYMRIE.gapp file located in the WNLT folder and click Open

é Select a file for this resource

x

Look In: l[ﬁ' WHLT

Y @] (@] (&) (e

[ﬁ‘ .git [ﬁ’ gramrmar [ﬁ’ wnlt-datastore
[ settings (& 1ib | CYMRIE.gapp
[ﬁ‘ bin [ﬁ’ plugins | E| TwitterCYMRIE.gapp
[ﬁ‘ dist [ﬁ‘ resources
[ﬁ‘ doc [ﬁ’ 5IC
[ﬁ‘ gazetteer [ﬁ‘ twitter-normaliser
File Name: TwitterCYMRIE.gapp
Files of Type: | GATE Application files (.gapp, xgapp) | ']

[[bm]l[:an::elj

The TwitterCymrlE application is now loaded into GATE Developer and can be used in a

similar fashion as outlined in 2.2 Loading the CymrlE system in GATE. There is a corpus of

Welsh JSON tweets in the wnlt-datastore, to open the datastore follow the instructions

outlined in section 2.3 Adding a New Corpus in GATE.

6.7. WNLT’s GUI

The main functionality of CymrlE in WNLT’s GUI is described in chapter 3. As well as the
CymrlE information extraction system the TwitterCymrlE information extraction system can

be used. Tweets can be imported by selecting the Twitter tab in the bottom left corner of

the application, see image below.
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The “Copy & Paste” tweet button allows the user to paste a raw tweet in a separate dialog
and the other buttons and text fields surrounded by the text “Twitter JSON import” allow
the user to load JSON sources supplied by Twitter’s API.

After selecting a document in the corpus an additional tab called “Normalisation (Twitter)”
is visible which displays all of the normalisations that took place using the TwitterCymrlE
information extraction system.

[£] WNLT GUI - CymrlE information extraction system
File
Corpus

FILE: C:\Users\Daniel\Deskiop\WHNLT\DataiWelsh-Twitter-JSO &

JSON-FILE: C\Users\Daniel\DeskiopWNLT\Data\Welsh-Twitte;
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Add documents
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=y
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=i
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URL  hitp.// Add
File(s) Add
Copy & Paste Twitter JSON Add L
v
- Twitter Tokens | Lemmas l Part Of Speech Tags l Token Types l Orthography l Normalisations (Twitter) l Sentences l Named Entities | Lookup | CymrE

6.8. WNLT’s CLI

Chapter 4 outlines how to use the WNLT’s command line interface. As can be seen from the
help message produced by the command line interface below, there is an additional
command for Twitter JSON sources called ‘normalisation’. This command saves all of the
normalisations that took place using the TwitterCymrlE information extraction system. As
the TwitterCymrlE information extraction system is based on CymrlE, all of the other
commands can be used on Twitter JSON sources.
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Bl Command Prompt - O X
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6.9. WNLT API
Instructions on how to setup the WNLT API and use CymrlE is detailed in chapter 5. This
section expends on chapter 5 and outlines the functionality for Twitter.

6.9.1. Using the TwitterCymrlIEUtilities class

The TwitterCymrlEUtilities class is located in the Java package wnlt.api.twitter. The class
has a function called getTwitterCymrlE() that creates a new instance of the TwitterCymrlE
information extraction system in one line of code, see line 2 of code snippet below.

1. try {

2. ConditionalSerialAnalyserController cymrie =
TwitterCymrIEUtilities.getTwitterCymrIE();

3 Corpus corpus = getCorpus();

4 cymrie.setCorpus(corpus);

5 cymrie.execute();

6.

7. } catch (GateException e) {

8 e.printStackTrace();

9. } catch (IOException e) {

10. e.printStackTrace();

11. }

The TwitterCymrlEUtilities class also allows the user to get preconfigured processing
resources used in the TwitterCymrlE information extraction system. In addition to the
processing resources in the CymrlE information extraction system, other processing
resources in TwitterCymrlE can be obtained from the following functions in the
TwitterCymrlEUtilities class:

e Annotation set transfer()
e Language identification()
e Emoticons Gazetteer()

e Hashtag Gazetteer()
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e Tweet Normaliser()

The default parameter settings for each of these processing resources can also be obtained
by calling the functions with the DefaultParameters suffix.

6.9.2. Using the TwitterCymrlIE class

The TwitterCymrlE class is located in the Java package wnlt.api.twitter. This class provides
functionality for typical use cases of the TwitterCymrlE information extraction system. This
class is targeted towards non-GATE Embedded developers and hides all GATE API code from
the user.

This TwitterCymrIE Object behaves similarly to CymrIE with the addition of an extra method
to obtain the normalisations performed by TwitterCymrlE and some functions in the
IESystem class were overridden. The functions are outlined in the following images.

O  TwitterCymrlE
@ TwitterCymirlE() ®
@ setTwitter)SOMN(5tring[]) : void
@ setTwitter)SOM(String) @ void
@ o setStrings(String(]) : void

CyrmrlE
e CymrlEQ
@ getTokens() : String[][]

@ getlemmas() : String[][]
® . setdtring(String) : void @ getPartOfSpeechTags() : String(][]
@ . setFiles(File[]]) : void @ getTokenTypes( : Stringl][]
® . setFile(File) : void @ getOrthographies() : String[][]
@ o setURLS{URL]) : void @ getSentenceSplits() : SentenceSplit[][]
® . setURL(URL): void @ getMamedEntities() : MamedEntity[][]
® getNormalisations() : String[I[] @ getlookups(): Lookup(][]
(®" |ESystem

@ =etURL{URL) : void

@ setFile(File) : void

@ setString(String) @ void

@ =etURL=(URL[]) : void

@ setFiles(File[]) : void

@ setStrings(String(]) : void

TwitterCymrlE inherits from CymrlE which inherits from IESystem.

The functions in the IESystem class were overridden to explicitly set each data source’s
mime type to be of the Twitter JSON format. The only exception is the setString and
setStrings methods accept tweet(s) and place each String into the Twitter JSON format so
that it can be treated as Twitter JSON. More information about each method in the
TwitterCymrlE class can be found in the supplied Javadoc documentation.
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